When multiple worksheets have identical layouts and labels, you can summarize data with the Consolidate command. You can also link to data in a different workbook to build a formula or display information. In this chapter, you will learn how to consolidate data from multiple sheets in the same workbook and how to link multiple workbooks with an external reference formula. You will also insert SmartArt graphics, screenshots, and hyperlinks in a worksheet.
Student Learning Outcomes (SLOs)
SLO 5.1 Create a static data consolidation.
SLO 5.2 Create a dynamic data consolidation.
SLO 5.3 Consolidate data by category.
SLO 5.4 Group worksheets for editing and formatting.
SLO 5.5 Link workbooks to consolidate data.
SLO 5.6 Insert illustrations using SmartArt, screenshots, and pictures in a worksheet.
SLO 5.7 Insert hyperlinks in a worksheet.
SLO 5.8 Safeguard work by marking it as final or by setting a password.
Case Study
Paradise Lakes Resort will be used for the Pause & Practice projects in this chapter.
SLO 5.1 Create a static data consolidation.
SLO 5.1 Create a static data consolidation.

A **consolidated worksheet** summarizes data from multiple sheets with a mathematical or statistical function. The *Consolidate* command on the *Data* tab calculates totals, averages, or other functions for data from multiple worksheets. Worksheets must have common data in the same rows and columns on each sheet for consolidation by *position*.

A **consolidation worksheet** is a separate summary sheet in the workbook. You create a consolidation sheet by copying one of the *source worksheets*. On the consolidation sheet, delete the contents of cells to be consolidated. You must create the consolidation worksheet before you start the *Consolidate* command.

**Static Data Consolidation**

A **static consolidation** summarizes the data and displays a result on the consolidated sheet. The result does not change when a value on any source worksheet is edited.
SLO 5.2 Create a dynamic data consolidation.
SLO 5.2 Create a dynamic data consolidation.

A dynamic consolidation places formulas on the consolidated sheet in an outline. When data on a source worksheet is edited, the formula recalculates. You should use dynamic consolidation when data on source worksheets might be edited after you have created the consolidation worksheet.

**Dynamic Data Consolidation**
You build a dynamic consolidation sheet the same way that you build a static consolidation sheet. In the *Consolidate* dialog box, however, choose the option to create links to the source data. The resulting outline in the consolidation sheet uses 3D reference formulas. The formulas identify the sheet name and cell used for consolidation. In a dynamic consolidation, you can expand outline items to display individual values that are summarized.
SLO 5.3 Consolidate data by category.
SLO 5.3 Consolidate data by category.

When data in multiple worksheets is arranged differently but has the same row and column labels, you can build a consolidation by category. Category refers to the row or column labels. Consolidation by category can be static or dynamic.

**Data Consolidation by Category**

To consolidate data by category, copy one of the source worksheets. On the consolidation sheet, delete the contents of cells to be consolidated including the labels. When you select the range on each source sheet, select the same range. In the Consolidate dialog box, you activate the option to use the top row or left column labels or both.
SLO 5.4 Group worksheets for editing and formatting.

After covering SLO 5.4, assign Pause & Practice 5-1.
You can group worksheets that have identical layouts for common editing or formatting. Group sheets to change a font, to apply a fill color, to set alignment, to edit data, and more.

Not all commands work for grouped worksheets. For example, you cannot insert a graphic on grouped sheets, nor can you apply conditional formatting. When sheets are grouped and a command is not available, the command button or option is grayed out in the Ribbon.

**Group Worksheets**

When worksheets are grouped, the title bar shows [Group] after the file name, and commands or edits affect all sheets in the group. The tabs for grouped worksheets appear white with a hint of the tab color below the sheet name. When grouping sheets, you may find it helpful to set different tab colors so that it is easier to recognize grouped sheets.

**Edit and Format Grouped Worksheets**

All worksheets in a group affected by a command, so worksheets should be identical in layout. If they are not, you might make changes that are not appropriate for every sheet in the group.
One command that you *can* apply to grouped sheets that are not identical is a header or footer command. You can also change page orientation for multiple sheets that are not identical.
SLO 5.5 Link workbooks to consolidate data.

After covering SLO 5.5, complete Pause & Practice 5-2.
SLO 5.5 Link workbooks to consolidate data.

**Linking** workbooks is the process of referring to data in another workbook. Linking may display data, or it may reference data for a formula. Linked workbooks are referred to as **dependent** and **source workbooks**. A dependent workbook includes or refers to data from another workbook. A source workbook includes data that is referenced in a dependent workbook. For workbooks to be linked, they must be accessible over a network, on the same computer, or in the cloud. Paradise Lakes Resort maintains a consolidated income workbook (a dependent workbook), but each location builds its own workbook (source workbooks). The consolidated workbook displays up-to-the-minute data because it includes links to each of the individual workbooks.

Link workbooks using the *Consolidate* command, or build formulas that refer to cells in other workbooks. Whether the reference is entered in the *Consolidate* dialog box or in a formula, it is an **external reference** because it refers to cells in another workbook.

**Link Workbooks Using the Consolidate Command**

An external reference includes the name of the workbook in square brackets, the
sheet name, cell address(es), and **identifiers**. An identifier is a character such as an exclamation point that marks or signifies a component of the reference. The complete syntax for an external reference is:

```
=’[WorkbookName]WorksheetName’!CellRange
```

All workbooks must be open when you use the *Consolidate* command.

**Link Workbooks Using a Formula**

The *Consolidate* command includes a limited list of functions and requires that the same cell range be referenced in all worksheets. These limitations do not apply in an external reference or linking formula.

An external reference formula refers to cells in another workbook and establishes a link to the source workbook. When the source workbook is open, you can point to build the formula. The source workbook need not be open to build an external reference formula, but you must type the formula with proper syntax and all identifiers.

When you point to create an external reference, it is built with absolute references. You can edit the references to be relative or mixed when you plan to copy the formula.

**Examine and Edit Links**

An external reference formula creates a **link** to the source workbook, a data connection. The link specifies the file name and location at the time the formula was created. You can choose how links are handles when a workbook is opened from the *Trust Center Settings for External Content* (Excel Options).

Links can be updated when the source workbook is accessible. If a source workbook was renamed or moved to another location, the link cannot be updated. When this happens, a dependent workbook shows a result for the formula, but it may not be accurate until you edit the link.

You can break a link to remove the data connection but keep formula results as values in the dependent workbook.
SLO 5.6 Insert illustrations using SmartArt, screenshots, and pictures in a worksheet.

After covering SLO 5.6, assign Guided Project 5-3; and Improve It Project 5-7.
SLO 5.6 Insert illustrations using SmartArt, screenshots, and pictures in a worksheet.

You can assist readers in understanding and navigating through your work in different ways. For example, include a link to direct users to another worksheet or to other locations in the same sheet. You might include a picture of folder contents to help a coworker learn file location.

**SmartArt Graphics**

A *SmartArt* graphic is an illustration, usually with text, in an Excel worksheet. Examples:
- Organization charts
- Matrices
- Pyramids
- Bulleted lists
- Similar diagrams

*SmartArt* graphics are text-focused but some may include pictures. A *SmartArt* graphic has a pane for entering text, but you can also type directly inside the component shapes. The text pane appears on the left or right side of the graphic depending where the graphic is positioned. As you type an entry, the text and its
shape are sized to fit the content.
A SmartArt graphic is not linked to worksheet data.

**SmartArt Tools**
A SmartArt graphic is an object that you can select, size, and format. It has selection and sizing handles as well as a bounding frame, similar to a chart object. A SmartArt graphic is one object that consists of several smaller shapes.

When you insert a SmartArt image, it is placed with the default number of shapes. For many SmartArt diagrams, you can add or remove shapes. Each individual shape in a SmartArt object has its own selection handles, a rotation handle, and a bounding frame.

When a SmartArt object is selected, the SmartArt Tools Design and Format tabs are available. From the tabs, you can change to a different image, choose a style, add a shape, reposition shapes, and add fill, outline, and effects.

A SmartArt graphic rests on an invisible, transparent layer in the worksheet, covering cells. You can activate a worksheet cell that appears within the frame of the SmartArt by typing the cell address in the Name box or by moving the image.
SLO 5.6 Insert illustrations using SmartArt, screenshots, and pictures in a worksheet.

**Screenshots**

A *screenshot* is a picture of a full or partial computer screen inserted as an object in a worksheet. You can capture an image of an open window or select a portion of a document or text from a web site. When capturing screenshots of web pages or another person’s work, you should have permission from the author or owner to use the image.
SLO 5.6 Insert illustrations using SmartArt, screenshots, and pictures in a worksheet.

**Picture Tools**
A screenshot graphic is a picture object with selection and sizing handles, a rotation handle, and a bounding frame. When the object is selected, the *Picture Tools Format* tab is available with command groups for altering the appearance of the image. Like a *SmartArt* graphic, a screenshot image is placed on the invisible, transparent layer of the worksheet.

**Pictures**
You can place pictures in an Excel worksheet for clarification, emphasis, or visual appeal. Insert pictures from a file or online sources. Always investigate copyright issues when you use pictures from outside sources.
SLO 5.7 Insert hyperlinks in a worksheet.

After covering SLO 5.7, assign Independent Project 5-6; and Challenge Projects 5-8 and 5-9.
SLO 5.7 Insert hyperlinks in a worksheet.
A **hyperlink** is a clickable text string or object that, when clicked, moves the pointer to another location. A hyperlink can also open another workbook or a web page. You might use a hyperlink to open a source workbook, to switch to another worksheet, or to navigate to a **SmartArt** image.

**Cell Hyperlinks**
A cell hyperlink is a text shortcut or jump term in a cell. It appears as underlined text in the color set in the document theme for hyperlinks. After a hyperlink is created, you can change the font color, font name, and font size from the mini toolbar or from the **Font** group on the **Home** tab. The **Hyperlink** button is located on the **Insert** command tab. You can also insert a hyperlink from the shortcut menu for a cell.

**Object Hyperlinks**
An object hyperlink is a shortcut assigned to an object such as a **SmartArt** graphic, a chart, or a picture. There is no underlined text, but you can use the hyperlink **ScreenTip** to provide information.
SLO 5.8 Safeguard work by marking it as final or by setting a password.

After covering SLO 5.8, complete Pause & Practice 5-3; assign Guided Projects 5-1 and 5-2; Independent Projects 5-4 and 5-5; and Challenge Project 5-10.
SLO 5.8 Safeguard work by marking it as final or by setting a password.

Excel has two commands that provide a simple level of security to protect your work from unwanted changes. One command is a courtesy message or warning and one command is the assignment of a password.

**Mark a Workbook as Final**
To let others know that your work is complete and should not be edited, use the *Mark as Final* command which sets a read-only file property. When the workbook opens, you will see a security message bar, an icon in the Status bar, and a [Read-Only] label in the title bar. You and others can remove the property by clicking the *Edit Anyway* button in the security message bar.

**Encrypt a Workbook with a Password**
Password protection requires that you type the password as you open the workbook. After you set a password, the *Protect Workbook* button [File tab, Info pane] indicates that the workbook requires a password.
To remove a password, you must open the workbook and enter the password. Then click the *Protect Workbook* button, select *Encrypt with Password*, delete the
password, leave the Password box empty, and resave the workbook.
Create a static data consolidation
A **consolidated worksheet** combines data from multiple worksheets using a mathematical or statistical function. When labels and values are in the same position on all worksheets, the consolidation is by position. A **static consolidation** places a non-changing result in the consolidation sheet. If the source data is edited, the consolidated sheet is not updated. The **Consolidate** button is located on the Data tab in the *Data Tools* group.

Create a dynamic data consolidation.
A **dynamic consolidation** places formulas in the consolidation worksheet. If the source data is edited, the consolidated sheet is automatically updated. A dynamic data consolidation formats the results as an Excel outline. To build a dynamic consolidation, choose the *Create links to source data* option in the *Consolidate* dialog box.

Consolidate data by category.
When labels and values are not in the same position on all worksheets, you may be able to consolidate data by category.
A category is a row or column label. A consolidate by category command includes the label cells on the source worksheets. The consolidated sheet displays labels in the same order as the first sheet listed in the Consolidate dialog box. Consolidation by category can be static or dynamic.

**Group worksheets for editing and formatting.**

When worksheets are grouped, editing and format commands affect all sheets in the group. You can apply formats, enter formulas, or enter data in grouped sheets. Not all commands are available in grouped sheets. When a command is not available, it is grayed out in the Ribbon. Press Shift or Ctrl to group contiguous or noncontiguous sheets. Ungroup sheets when finished editing to guard against applying a command in error to the group.

**Link workbooks to consolidate data.**

*Linking* workbooks is the process of referring to data in another workbook. A *dependent workbook* refers to data in another workbook. A *source workbook* supplies data to another workbook. An *external reference* formula is in a dependent workbook and refers to cells in a source workbook. An external reference includes the name of the workbook, the sheet name, cell addresses, and identifiers. You can link workbooks by using the Consolidate command on the Data tab if all source workbooks are open. You can link workbooks by building a formula that refers to another workbook. You can point to build an external reference formula if the source workbook is open. If the source workbook is not open, build an external reference formula by typing the complete path and file name, the sheet name, cell addresses, and all identifiers. The Excel Trust Center includes security options for workbooks with links.

**Insert illustrations using SmartArt, screenshots, and pictures in a worksheet.**

A *SmartArt* graphic is an illustration such as a matrix, a cycle diagram, an organization chart, or a process chart. A *SmartArt* graphic is a selectable object that you can size, position, and style. *SmartArt* graphics are not linked to worksheet data; they contain descriptive text. When a *SmartArt* graphic is selected, the *SmartArt Tools Design* and *Format* tabs are available. A *SmartArt* graphic consists of several smaller shapes; you can format an individual
shape separately.

A **screenshot** is an image of data on the screen that is inserted as a picture object in a worksheet.

The **Take a Screenshot** button displays thumbnails of open windows that you can capture as images.

You can take a **Screen Clipping** by drawing a rectangle around the desired area.

Pictures can be inserted in a worksheet from a file or from online sources.

When a picture object is selected, the **Picture Tools Format** tab is available with commands for changing the appearance of the image.

---

**Insert hyperlinks in a worksheet.**

A **hyperlink** is a clickable line of text in a cell or a clickable object in a worksheet.

A hyperlink acts as a jump term or a shortcut to another location in the workbook, on the computer, or in the cloud.

A cell hyperlink is underlined text in the color specified by the document theme.

An object hyperlink is a shortcut assigned to an image, a **SmartArt** graphic, or another object.

The **Hyperlink** button is located in the Links group on the **Insert** tab.

---

**Safeguard work by marking it as final or by setting a password.**

You can assign a simple level of security to a workbook by marking it as final.

The **Mark as Final** command is a reminder that the work is complete and should not be edited.

You can remove the **Mark as Final** setting by clicking **Enable Editing** in the security message bar.

The **Encrypt with Password** command allows you to assign a password to a workbook.

You must type the password before the workbook can be opened.

The **Mark as Final** and **Encrypt with Password** commands are available from the **Protect Workbook** button [File tab, Info pane].